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Проектирование и моделирование 
печатных плат в САПР Allegro
Часть 1

Компания Parallel Systems выпустила материал для обучения новых 

пользователей возможностям САПР Allegro/OrCAD, таким как создание 

и моделирование схем и трассировка плат. Востребованность 

этого материала побудила автора к написанию цикла статей по 

проектированию и моделированию печатных плат в бесплатной версии 

программы – OrCAD Lite.

Александр Панов (Москва)

Несмотря на то, что инструменты 

Cadence Allegro и OrCAD предназна-

чены для решения самых сложных 

инженерных задач, в рамках данной 

статьи и последующих будут рассмо-

трены только основные элементы 

процесса разработки, ограниченные 

следующими правилами:

 ● всё описанное можно будет выпол-

нить в бесплатной версии програм-

мы OrCAD Lite, доступной для скачи-

вания с сайта www.orcad.com;

 ● будут охвачены основные приё-

мы работы в OrCAD Capture, PSpice 

и Allegro PCB Editor;

 ● все действия разбираются настолько 

детально, что любой пользователь, не 

имевший до этого дела с продуктами 

OrCAD, сможет их понять и выпол-

нить;

 ● будут пройдены все этапы типово-

го процесса проектирования, начи-

ная с пустого листа схемы и закачи-

вая готовой топологией;

 ● потребуется всего несколько часов, 

чтобы выполнить весь цикл проек-

тирования.

Для установки OrCAD Lite необходимо 

скачать его по ссылке www.orcad.com/ru/

buy/try-orcad-for-free и выполнить уста-

новку. Процесс инсталляции займёт не 

более 15 мин. Необходимо выбрать пол-

ный вариант установки и типовые пути 

к корневым каталогам установки САПР.

В этой и последующих статьях цик-

ла проектирование и моделирова-

ние печатных плат в OrCAD Capture 

и PSpice описывается на примере соз-

дания простой схемы усилителя звука 

для наушников. На рисунке 1 показа-

на схема, уже подготовленная для spice-

моделирования, с разъёмами для раз-

мещения на плате.

ВВЕДЕНИЕ В РЕДАКТОР СХЕМ

Создание проекта

Процесс работы начинается с запу-

ска OrCAD Capture, Allegro Capture CIS 

или OrCAD Capture CIS Lite. В открыв-

шемся приложении Capture используй-

те команду File > New > Project…, что-

бы создать новый проект (см. рис. 2), 

выберите Project Type – PSpice Analog 

Mixed A/D, чтобы в дальнейшем иметь 

возможность промоделировать схему. 

Укажите папку для проекта и его имя, 

например, Headphone (наушники).

Затем в следующем окне можно 

выб рать шаблон проекта empty.obj 

(см. рис. 3).

При наличии разных вариантов про-

граммы, которые можно использо-

вать для дальнейшей симуляции, нуж-

Рис. 1. Полная схема устройства
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но выбрать самый простой вариант – 

OrCAD Lite (см. рис. 4).

Добавление библиотек к проекту

Работа со схемой начинается с выбо-

ра и добавления библиотек. Для этого 

раскройте последовательно закладки 

в дереве проекта и найдите лист Page1. 

Откройте его двойным щелчком левой 

кнопки мыши (ЛКМ) и выберите коман-

ду Place > Part из меню либо из панели 

инструментов. Затем нажмите кнопку 

добавления необходимых библиотек 

(см. рис. 5).

Когда откроется окно проводни-

ка для выбора библиотек, перейди-

те в папку C:\Cadence\SPB_17.2, затем 

в папку tools\Capture\library\pspice 

(см. рис. 6), где будут находиться библи-

отеки со spice-моделями. Добавьте их 

все, выделив первую 1_shot и, зажав 

стор) из библиотеки   Breakout. Для 

этого в меню Place > Part в окне Part 

нужно написать POT. Это позволит 

перейти к данному компоненту в спи-

ске. Необходимо следить за тем, что-

бы в списке ниже была выбрана необ-

ходимая библиотека (её имя долж-

но иметь синий фон). Когда символ 

выбран для размещения, его можно 

поворачивать с помощью клавиши R 

или команды Rotate из меню, вызыва-

емого нажатием правой кнопки мыши 

(ПКМ). Разместите все переменные 

резисторы, а затем прервите коман-

ду с помощью нажатия Esc или ПКМ > 

End Mode.

Двойным нажатием на символ 

откройте таблицу с его свойствами и 

поменяйте значение Value с первона-

чального 1k на 50k. Либо можно выде-

лить сам параметр, два раза нажать на 

Рис. 2. Создание нового проекта

Рис. 5. Выбор необходимых библиотек 

из стандартного набора

Рис. 3. Выбор шаблона проекта

Рис. 6. Просмотр пути к файлам доступных библиотек

Рис. 7. Размещение 

резисторов на схеме

Рис. 4. Выбор САПР из доступных вариантов

кнопку Shift, последнюю Zetex (выде-

лятся все между ними). Далее нажми-

те кнопку Открыть. Указанные пути 

к библиотекам используются по умол-

чанию при установке программ. Если 

при установке они были изменены, сле-

дует ориентироваться на новые корне-

вые каталоги.

Размещение символов

В качестве основы используется 

готовая схема, приведённая на рисун-

ке 1. Используя её, нарисуем собствен-

ную в схемном редакторе Capture. 

Конечно же, точное размещение эле-

ментов не требуется, но необходимо 

следить за взаимным подключением 

компонентов, чтобы получить иден-

тичный результат. После того как 

были добавлены библиотеки, выбе-

рите  символ POT (переменный рези-
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текст 1k, поменять его значение на 50k 

и сохранить изменения нажатием OK. 

Текст и символы на схеме можно пере-

мещать, выполнив выделение одиноч-

ным нажатием ЛКМ, а затем перетя-

гивая их на нужное место. Сохрани-

те внесённые изменения, используя 

команду File > Save.

Теперь разместим подобным обра-

зом обычные резисторы, используя 

символ R из библиотеки Analog. Рези-

сторы можно размещать, наклады-

вая концы их выводов друг на друга. 

Тогда они будут сразу же соединять-

ся. Останется только растащить их на 

нужное расстояние. Можно поставить 

несколько резисторов, добавить им 

необходимые номиналы, а остальные, 

такие же, вставить, используя копи-

рование. Для этого выделите сим-

вол и потяните его с зажатой кноп-

кой Ctrl. В итоге должна получиться 

цепочка, подобная изображённой на 

рисунке 7.

После резисторов разместите кон-

денсаторы С1…С3. Поскольку речь 

касается моделирования в PSpice, 

используются неполяризованные кон-

денсаторы. В реальной плате с боль-

шими номиналами могут потребо-

ваться электролиты, но сейчас это не 

играет роли. Используйте символы С 

из библиотеки Analog, укажите у них 

необходимые номиналы. В случае если 

позиционные обозначения были ука-

заны вручную, они будут подчёркнуты. 

Позже, после проведения перенумера-

ции, подчёркивание пропадёт. Если 

понадобится, для соединения выво-

дов используйте команду Place Wire. 

Её можно вызвать нажатием клави-

ши W либо из меню Place > Wire, либо 

нажатием кнопки на панели инстру-

ментов. Нажав ЛКМ, начинаем вести 

цепь из конца вывода компонента. 

Также используем нажатия ЛКМ для 

прокладки пути. Необходимо обра-

тить внимание на места пересечения 

проводников: в случае подключения 

их друг к другу там должна появлять-

ся соединительная точка.

Перейдём к размещению транзи-

сторов. При размещении транзисто-

ра BC212 PNP можно выполнить его 

зеркальное отражение через нажатие 

ПКМ > Mirror Vertically. Оба компо-

нента, BC182BP и BC212BP, находятся 

в библиотеке Zetex.

Остаётся дорисовать правую часть 

схемы, используя транзисторы TIP41 

и TIP42 из библиотеки Pwrbjt и резисто-

ры из библиотеки Analog. Проследите 

за расположением эмиттера у транзи-

сторов и при необходимости исполь-

зуйте команды по зеркальному отраже-

нию, которые вызываются из контекст-

ного меню нажатием ПКМ.

Именование цепей

Всем соединениям, которые нарисо-

ваны на схеме, автоматически присва-

ивались названия в формате N плюс 

индивидуальный номер. Чтобы в даль-

нейшем было легче ориентировать-

ся, можно задать цепям другие име-

на. Для этого необходимо восполь-

зоваться командой Place > Net Alias 

(можно вызвать её нажатием клави-

ши N). Окно команды изображено на 

рисунке 8.

Сверху окна указывается новое 

имя цепи. При желании можно ука-

зать цвет и ориентацию названия. 

Введём MID и нажмём OK. Новое имя 

будет прикреплено к курсору, пока 

его не назначат какой-либо цепи. 

Следует помнить следующие нюан-

сы. Если название цепи заканчивает-

ся на номер, то при расстановке его 

на схеме, будет происходить автома-

тическое увеличение номера (после 

A0 будет присвоено A1 и так далее). 

Также надо помнить, что, если двум 

отдельным цепям на одном листе 

будет присвоено одно и то же назва-

ние, то в дальнейшем они будут счи-

таться электрически соединённы-

ми, даже если они не связаны лини-

ей. Назначим название MID цепи на 

стыке двух выходных транзисторов 

справа (см. рис. 1).

Добавление источников питания 

и символа земли

Для завершения схемы добавим 

источники питания. Добавьте сим-

вол VSIN из библиотеки Source (V1 на 

рисунке 1) и задайте ему параметры 

VOFF=0, VAMPL=10m, FREQ=1k и AC=1. 

Это будет обозначать источник сину-

соидального напряжения с амплиту-

дой 10 мВ и частотой 1 кГц для моде-

лирования переходных процессов, 

а также источник напряжения в 1 В 

для моделирования AC Sweep. Подроб-

но о них будет рассказано в следую-

щих статьях. Добавляем символ VDC 

из библиотеки Source (V2 на рисун-

ке 1). Заменим ему значение 0Vdc на 

20 (PSpice-симулятор «знает», что это 

величина постоянного напряжения, 

поэтому суффиксами Vdc или V мож-

но пренебречь).

Остаётся добавить символ зем-

ли, который необходим в PSpice-

моделировании для задания 0 в схеме. 

Он находится в библиотеке Capsym. 

Для этого используйте команду Place > 

Ground (см. рис. 9).

После этого назначьте имена цепям 

IN, OUT и VPP, используя команду Place 

> Net Alias. Во время размещения можно 

нажать Ctrl+E для входа в меню коман-

ды и задания новых имён.

Перенумерация компонентов

Чтобы обозначения располагались 

по порядку сверху-вниз, необходи-

Рис. 8. Выполнение команды Place > Net Alias 

(присвоить имя цепи)

Рис. 9. Символ земли в стандартной 

библиотеке   

Рис. 10. Выполнение автонумерации компонентов
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мо выполнить перенумерацию ком-

понентов. Для этого выделите про-

ект headphone.dsn в дереве проекта 

и запустите команду Tools > Annotate… 

с настройками, как это показано на 

рисунке 10. Сначала сбросьте все зна-

чения, используя пункт Reset part 

Рис. 11. Схема после перенумерации компонентов

reference to «?», затем пронумеру й-

те, переключившись на Incremental 

reference update с опцией Annotate 

type – Top-Bottom. Результат перенуме-

рации показан на рисунке 11. На этом 

можно закончить и сохранить проект 

(File > Save).

ЗАКЛЮЧЕНИЕ

Выполнив описанные действия, вы 

создали схему, содержащую все необ-

ходимые для работы усилителя звука 

компоненты. В следующей статье будет 

описано моделирование работы полу-

ченной схемы.

Новости мира  News of the World  Новости мира

Qualcomm собирается 
купить NXP Semiconductors 
за $37 млрд

Американский разработчик микропро-

цессоров Qualcomm близок к приобрете-

нию голландской полупроводниковой ком-

пании NXP Semiconductors. Благодаря этой 

сделке покупатель сможет освоить новые 

сегменты процессорного рынка. О планах 

Qualcomm по поглощению NXP агентству 

Reuters стало известно от осведомлённого 

источника. По его информации, речь идёт 

о сумме в $37 млрд или $110 за акцию гол-

ландской компании.

Qualcomm является самым крупным 

в мире поставщиком систем-на-кристалле 

для различных мобильных устройств и теле-

коммуникационного оборудования. Соглас-

но данным IHS, в прошлом финансовом 

году выручка компании составила более 

$25,28 млрд ($17,15 млрд принесли прода-

жи микросхем, $7,95 млрд – лицензирова-

ние технологий), что делает Qualcomm чет-

вёртым поставщиком микросхем в мире по 

уровню дохода.

В случае успешного завершения сделки 

Qualcomm, которая является одним из глав-

ных поставщиков чипов для Apple, а также 

Android-производителей, выйдет на рынок 

чипов для автомобилей. Это важный шаг 

для компании, особенно в условиях замед-

ления продаж смартфонов и роста конку-

ренции со стороны китайских и тайваньских 

производителей.

Руководство Qualcomm ранее избегало 

крупных приобретений, опасаясь брать на 

себя риски, связанные с покупкой компа-

ний, которые выходят за рамки довольно 

узкой специализации Qualcomm.

По итогам прошлого года NXP 

Semiconductors была седьмым по объёму 

выручки поставщиком микросхем с дохо-

дом $9,72 млрд. Нужно заметить, что сде-

лать скачок с пятнадцатого места ей помог-

ло приобретение Freescale Semiconductor. 

Последняя обошлась голландскому чипмей-

керу в $12 млрд. В результате объедине-

ния появилась полупроводниковая компа-

ния с рыночной стоимостью $40 млрд.

NXP Semiconductors производит анало-

говые и цифровые микрочипы для авто-

мобилей, медицинского оборудования 

и др. Bloomberg утверждает, что заклю-

чение сделки может последовать сра-

зу же после выхода квартального отчёта 

NXP, или может быть отложено до отчё-

та Qualcomm. Однако договор о покупке 

пока не подписан.

Прошлый год стал рекордным с точки зре-

ния суммарной стоимости M&A-соглашений 

между производителями микросхем – 

$103,8 млрд (данные IC Insights). За этот 

год в полупроводниковой отрасли было 

объявлено о 20 сделках на общую сумму 

$55,3 млрд.

www.pcweek.ru
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Новости мира  News of the World  Новости мира

Achronix предлагает встраивать 
FPGA в процессоры

На заре своего появления в 1980-х гг. 

программируемые матрицы FPGA (ПЛИС) 

выступали в качестве связующего зве-

на между дискретной логикой и, по сути, 

представляли собой гибко программируе-

мый интерфейс. По мере совершенствова-

ния и с увеличением плотности и числа вен-

тилей в их составе, матрицы стали способны 

на большее – работать в качестве ускори-

телей вычислений определённых задач. 

Сегодня матрица FPGA может считаться 

полноценным сопроцессором, а стараниями 

компании Intel матрицы могут располагаться 

на одной и той же подложке с центральным 

процессором. Может ли быть что-то лучше? 

Очевидно, только матрица, интегрирован-

ная в кристалл процессора.

Матрицы для интеграции в состав одно-

кристальных схем (и процессоров) пред-

ложила компания Achronix. Специали-

сты компании разработали полностью 

функцио нальный и готовый к интеграции 

в сторонние решения блок встраиваемой 

матрицы или eFPGA. Решение распростра-

няется на основе приобретения лицензии 

на данную интеллектуальную собственность 

Achronix. В компании рассчитывают, что рас-

пространение eFPGA значительно увеличит 

годовую выручку компании, которая толь-

ко в этом году вернулась к прибыльности. 

Так, в текущем году выручка Achronix обе-

щает достичь $12 млн, а в 2017 г., благода-

ря продвижению eFPGA, превысит $40 млн.

Интеграция матрицы в SoC устраняет 

эффект «бутылочного горлышка» – макси-

мально раскрывает потенциал по обмену 

данными между матрицей и вычислительны-

ми ядрами процессора. Задержки при обра-

щении к eFPGA снижаются до 2 нс, тогда 

как типичные задержки при обращении 

к отдельно стоящей матрице равны 30 нс 

и могут достигать 100 нс. Также уменьша-

ется площадь кристалла, выделенного под 

матрицу, и снижаются её энергопотребле-

ние и себестоимость – всё это, прежде все-

го, за счёт избавления от «лишних» интер-

фейсов, которые необходимы FPGA, уста-

навливаемым отдельно.

Надо отметить, что предложенные ком-

панией Achronix блоки eFPGA Speedcore 

IP базируются на той же самой архитекту-

ре и используют те же самые инструменты 

для работы, что и предыдущие «дискрет-

ные» матрицы Speedster 22i. Иными слова-

ми, клиенты Achronix не будут испытывать 

проблем, переходя на работу со встроенны-

ми матрицами eFPGA Speedcore.

Матрицы Speedster 22i по заказу Achro-

nix выпускает компания Intel, для чего 

использует 22-нм FinFET техпроцесс. 

Компания Achronix – одна из немногих, 

кто передал заказ на изготовление чипов 

контрактному подразделению Custom 

Foundry компании Intel. Блоки eFPGA 

Speedcore IP, напротив, созданы с при-

целом на производство компанией TSMC 

с использованием техпроцесса 16FF+. Так-

же в компании сообщили, что ведутся раз-

работки новой версии eFPGA IP для выпу-

ска с использованием технологических 

норм 7 нм.
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